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Introduction

    WARNING
The equipment covered by this publication must be installed, operated, and 
maintained by qualified persons who are knowledgeable in the installation, 
operation, and maintenance of overhead electric power distribution equipment 
along with the associated hazards .

A qualified person is one who is trained and competent in:

• The skills and techniques necessary to distinguish exposed live parts from 
nonlive parts of electrical equipment

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

• The proper use of the special precautionary techniques, personal protective  
equipment, insulating and shielding materials, and insulated tools for working 
on or near exposed energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not 
intended to be a substitute for adequate training and experience in safety 
procedures for this type of equipment .

NOTICE
Read this instruction sheet thoroughly and carefully before installing or operating 
an IntelliCap Plus Automatic Capacitor Control . Familiarize yourself with the 
Safety Information on page 4 and Safety Precautions on page 5 . The latest 
version of this publication is available online in PDF format at sandc.com/en/
support/product-literature/ .

This instruction sheet is a permanent part of the IntelliCap Plus Automatic Capacitor 
Control. Designate a location where you can easily retrieve and refer to this publication.

    WARNING
The equipment in this publication must be selected for a specific application . The  
application must be within the ratings furnished for the selected equipment .

The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheets 150 and 181, applies to the IntelliCap Plus Automatic Capacitor Control, 
except that the first paragraph of the said warranty is replaced by the following:

(1) General: The seller warrants to the immediate purchaser or end user for a 
period of 10 years from the date of shipment that the equipment delivered will 
be of the kind and quality specified in the contract description and will be 
free of defects of workmanship and material. Should any failure to conform 
to this warranty appear under proper and normal use within 10 years after 
the date of shipment, the seller agrees, upon prompt notification thereof and 
confirmation that the equipment has been stored, installed, operated, inspected, 
and maintained in accordance with the recommendations of the seller and 
standard industry practice, to correct the nonconformity either by repairing 
any damaged or defective parts of the equipment or (at the seller’s option) by 
shipment of necessary replacement parts. The seller’s warranty does not apply to 
any equipment that has been disassembled, repaired, or altered by anyone other 
than the seller. This limited warranty is granted only to the immediate purchaser 
or, if the equipment is purchased by a third party for installation in third-party 
equipment, the end user of the equipment. The seller’s duty to perform under any 
warranty may be delayed, at the seller’s sole option, until the seller has been paid 
in full for all goods purchased by the immediate purchaser. No such delay shall 
extend the warranty period.

Qualified Persons

Read this  
Instruction Sheet

Retain this  
Instruction Sheet

Proper Application

Special Warranty 
Provisions



  S&C Instruction Sheet 1023-540  3

Introduction

Replacement parts provided by the seller or repairs performed by the seller 
under the warranty for the original equipment will be covered by the above special 
warranty provision for its duration. Replacement parts purchased separately will 
be covered by the above special warranty provision.

Warranty of the IntelliCap Plus Automatic Capacitor Control is contingent upon 
the installation, configuration, and use of the control or software in accordance 
with S&C’s applicable instruction sheets.

This warranty does not apply to major components not of S&C manufacture, 
such as communication devices. However, S&C will assign to the immediate 
purchaser or end user all manufacturer’s warranties that apply to such major 
components.

Warranty of equipment/services packages is contingent upon receipt of 
adequate information on the user’s distribution system, sufficiently detailed to 
prepare a technical analysis. The seller is not liable if an act of nature or parties 
beyond S&C’s control negatively impact performance of equipment/services 
packages; for example, new construction that impedes radio communication, or 
changes to the distribution system that impact protection systems, available fault 
currents, or system-loading characteristics.
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Safety Information

Understanding 
Safety-Alert Messages

Following 
Safety Instructions

Replacement 
Instructions and 
Labels

Several types of safety-alert messages may appear throughout this instruction sheet 
and on labels attached to the IntelliCap Plus Automatic Capacitor Control. Familiarize 
yourself with these types of messages and the importance of these various signal words:

    DANGER
“DANGER” identifies the most serious and immediate hazards that will likely 
result in serious personal injury or death if instructions, including recommended 
precautions, are not followed .

    WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious 
personal injury or death if instructions, including recommended precautions, are 
not followed .

    CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE
“NOTICE” identifies important procedures or requirements that can result in 
product or property damage if instructions are not followed .

If you do not understand any portion of this instruction sheet and need assistance, 
contact your nearest S&C Sales Office or S&C Authorized Distributor. Their tele- 
phone numbers are listed on S&C’s website sandc.com, or call the Global Support and 
Monitoring Center at 1-888-762-1100. 

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating an IntelliCap Plus 
Automatic Capacitor Control .

If additional copies of this instruction sheet are needed, contact your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.
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Safety Precautions

    DANGER
The IntelliCap Plus Automatic Capacitor Control line voltage input range is 
93 to 276 Vac. Failure to observe the precautions below will result in serious 
personal injury or death.

Some of these precautions may differ from your company’s operating procedures 
and rules . Where a discrepancy exists, follow your company’s operating procedures 
and rules .

1 . QUALIFIED PERSONS. Access to the IntelliCap 
Plus Automatic Capacitor Control must be restricted 
only to qualified persons . See the “Qualified 
Persons” section on page 2 .

2 . SAFETY PROCEDURES. Always follow safe 
operating procedures and rules . Always maintain 
proper clearance from energized components .

3 . PERSONAL PROTECTIVE EQUIPMENT. Always 
use suitable protective equipment, such as rubber 
gloves, rubber mats, hard hats, safety glasses, arc-
flash clothing, and fall protection, in accordance 
with safe operating procedures and rules .

4 . SAFETY LABELS. Do not remove or obscure any 
of the “DANGER,” “WARNING,” “CAUTION,” or 
“NOTICE” labels and tags . Remove tags ONLY if 
instructed to do so .

5 . MAINTAINING PROPER CLEARANCE. Always  
maintain proper clearance from energized 
components .
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Hardware and Software

This instruction sheet was prepared for use with IntelliCap Automatic Capacitor Control 
software: PCSD126S and PCVD126S.

Software identification is available on the IntelliLink® Setup Software Product 
Information screen. For questions regarding the applicability of information in this 
instruction sheet to future product releases, please contact S&C Electric Company.

This section describes various capacitor control components. The following section, 
“Capacitor Control Operation” on page 14, explains how these components work together 
to monitor the distribution feeder and manage capacitor bank operation. Figure 1 shows 
hardware components of the capacitor control that may need to be accessed during 
regular operation and troubleshooting.

SCADA ports—The capacitor control has two SCADA ports. If the control includes 
communications equipment, it will usually be connected to Port A, labeled SCADA 
PORT on the faceplate.

Terminal strip—Every capacitor control includes a terminal strip; its configuration 
is shown on a label on the inside of the enclosure door. See Figure 1.  If necessary, 
reconfigure the wiring to the meter base plug or the connectors on the bottom of the 
control enclosure.

Applicable Software

Hardware 
Components

Test points—The test points help check the operation of the capacitor control; the 
configuration in Figure 1 is shown on a label on the inside of the enclosure door.

Yellow—Current sensor +

Red—Load

Black—Ac line

White—Neutral return

Figure 1. The capacitor control components.

Load fuse

Terminal strip

Test points
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Hardware and Software

Faceplate The capacitor control faceplate includes LEDs and buttons that enable monitoring and 
controlling the capacitor bank and the capacitor control. See Figure 2. It also includes 
an LCD screen and buttons for scrolling and selecting data.

Figure 2. The IntelliCap Plus Automatic Capacitor Control faceplate.

The faceplate includes the following LEDs:

Auto LED

This red LED is lit when automatic capacitor bank operation is enabled. Commands 
from the faceplate CLOSE and OPEN buttons are blocked.

Manual LED

This red LED is lit when automatic capacitor bank operation is disabled. When the 
LOCAL LED is also lit, the faceplate CLOSE and OPEN buttons can be used to operate 
the bank.

Close LED

This red LED is lit when the capacitor bank switch is closed. When a Manual  
Operation Delay period is specified, indicated on page 2 of the Setup>General screen, 
this LED blinks rapidly during the delay period prior to the switch closing.

Open LED

This green LED is lit when the capacitor bank switch is open. When a Manual  
Operation Delay period is configured, indicated on page 2 of the Setup>General screen, 
this LED blinks rapidly during the delay period prior to the switch opening. The LED 
blinks slowly while a reclose block is in effect.

Faceplate LED 
Displays
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Remote LED

This red LED is lit when remote (SCADA) control of the capacitor bank is enabled and 
faceplate operation is disabled.

Local LED

This red LED is lit when remote (SCADA) control of the capacitor bank is disabled and 
faceplate operation is enabled.

Note: The LOCAL LED must be on before changing between Automatic and Manual 
modes from the faceplate or with an IntelliLink software command.

SCADA Communications XMT/RCV LEDs

These LEDs blink when the capacitor control sends or receives signals through remote 
communications equipment installed in the control enclosure.

XMT LED—Blinks when the capacitor control sends one or more characters

RCV LED—Blinks when the capacitor control detects an incoming character

Note: The XMT and RCV LEDs only blink when remote-communications equipment 
is installed, properly connected, and receiving power. This optional equipment is 
usually a radio or modem board installed inside the capacitor control enclosure door.

Hardware and Software

Faceplate Buttons The faceplate includes the following buttons. For more information about how to use 
these buttons to control the capacitor bank, see the “Switching the Capacitor Bank” 
section on page 30.

Operation Mode CHANGE button

When the LOCAL LED is on, pressing this button toggles between enabling and disabling 
the Automatic Operation mode. When the Automatic Operation mode is enabled (the 
AUTO LED is lit), commands from the faceplate CLOSE and OPEN buttons are blocked.

Last Bank Command CLOSE button

When both the MANUAL and LOCAL LEDs are lit, pressing this button transmits a 
Close command to the capacitor bank switch. When the Automatic Operation mode 
is enabled (the AUTO LED is lit) or when the Remote Operation mode is enabled (the 
REMOTE LED is lit), pressing this button has no effect.

Last Bank Command OPEN button

When both the MANUAL and LOCAL LEDs are lit, pressing this button transmits an 
Open command to the capacitor bank switch. When the Automatic Operation mode 
is enabled (the AUTO LED is lit) or when the Remote Operation mode is enabled (the 
REMOTE LED display is lit), pressing this button has no effect.

SCADA Control CHANGE button

Press this button to enable or disable SCADA Control mode. When the REMOTE 
LED is lit, remote operation of the bank is enabled and faceplate operation is disabled. 
When the LOCAL LED is lit, remote operation of the bank is disabled and faceplate 
operation is enabled.

Note: The LOCAL LED must be lit when switching between Automatic  
Operation mode and Manual Operation mode from the faceplate or with an  
IntelliLink software command.
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NOTICE
When the Automatic Operation mode is enabled, the Automatic Control logic 
may switch the capacitor bank regardless of whether SCADA Control mode is 
enabled or disabled . To have full control of the capacitor bank, the MANUAL LED 
must also be lit .

NOTICE
Hayes-compatible modems connect to the control in a manner similar to IntelliLink  
software, using the LOCAL COMM PORT . Therefore, off-site control of the 
capacitor bank is not inhibited by the SCADA CONTROL CHANGE button . Bank 
operation is possible even when the SCADA CONTROL LOCAL LED is lit .

Lamp Test button

Press this button to test the LEDs on the faceplate. All LEDs should light.

The faceplate has a two-line, 16-character LCD screen. When the control is operating 
normally, the top line of the screen shows **UNIT OK**. The bottom line cycles through 
a list of real-time data, setpoints, and logged data as well as other operating information, 
such as an active alarm or a Reclose Block state.

Reclose Block

When the Reclose Block state is in effect, the LCD screen shows information on both 
lines. See Table 1.

Faceplate LCD Display

Table 1. Reclose Block LCD Screens
Display Meaning

**RECLOSE BLOCKED**
**seconds left ##**

After opening the capacitor bank, the capacitor 
control will not reclose it for 5 minutes . This allows the 
capacitors to discharge . The bottom line shows the time 
remaining before the control can switch the bank in .

**Reset RclBlkDly**
**Password=        **

This appears if the Reclose Block Reset Password 
setting is enabled and an attempt is made to close the 
bank while the reclose block is in effect . To bypass 
the block, press the faceplate NEXT or PREV button 
to scroll through the password list . Then, press the 
ENTER button when the LCD display shows the correct 
password . To end the procedure without bypassing the 
block, press the ESC button .
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Hardware and Software

Real-Time Data
The LCD screen scrolls through real-time data on the bottom line. See Table 2.

Table 2. Real-Time Data LCD Screens
Display Meaning

**Date** Today’s date

**Time** Present time

**Volt**; **Ovr** Line voltage (true RMS measured voltage); regardless of 
whether a voltage override is in effect

**NeutRmsAmps** Neutral amps (or voltage) RMS

**NeutFundAmp** Neutral amps (or voltage) fundamental

**Line kV** Var controls only; voltage level on the  
distribution line, in kV

**Line Amps** Var controls only; current level, in amps

**UnCorPh** Uncorrected phase angle

**CorrPh** Corrected phase angle

**Current Dir** Current flow direction

**PFactor** Power factor

**PF**; direction Var controls only; power factor; normal or  
reverse current flow

**Line kvar** Var controls only, kvar level

**Line kW** Var controls only, kW level

**Line kVA** Var controls only, kVA level

**Temp**; **Ovr** Present ambient temperature (in ºF or ºC, based on 
the value of the Temperature Readings Conversion 
setpoint on page 3 of the Setup>General screen); 
regardless of whether a temperature override is in effect

**VoltTHD** Voltage - percent Total Harmonic Distortion

**3rdVHarm** Voltage - percent 3rd Harmonic

**5thVHarm** Voltage - percent 5th Harmonic

**7thVHarm** Voltage - percent 7th Harmonic

**CurrTHD** Current - percent total harmonic distortion

**3rdCHarm** Current - percent 3rd harmonic

**5thCHarm** Current - percent 5th harmonic

**7thCHarm** Current - percent 7th harmonic

**NeutTHD** Neutral current - percent total harmonic  
distortion

**3rdNHarm** Neutral current - percent 3rd harmonic

**5thNHarm** Neutral current - percent 5th harmonic

**7thNHarm** Neutral current - percent 7th harmonic

**Evnt** Any active event messages, such as a low switching 
delta or a maximum automatic operations limit

TABLE CONTINUED ▶
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Note: The kvar level shown is calculated from measured sensor values; it is not an 
adjusted level.

Note: The capacitor control does not display High-Voltage Override and  
Low-Voltage Override setpoints when the present control mode is the Time-Biased 
Voltage mode, the Automatic Offline mode, or the Automatic Online mode.

Table 2. Real-Time Data LCD Screens—Continued
Display Meaning

**Active Season** The number of the season presently in effect

**Auto** The automatic control strategy for the present season

**SoftVer** The ID of the control software in the capacitor control

**OperCount** The total number of complete switching cycles since 
installation

**SwIn** The reason for the last switch-in of the bank

**SwOut** The reason for the last switch-out of the bank

**EstVChg+Mrg** The value of the Estimated Voltage Change + Margin 
setpoint

**NCAlrmLvl** Neutral current (or voltage) alarm level

**NCChgTime** Neutral current (or voltage) change time

**NCCorr** Neutral current (or voltage) corrective action

**NCRetry** Neutral current (or voltage) retry - enable or disable

**ZeroDet** Zero neutral sensor alarm (current or voltage)

**NSAlarming** Neutral sensing controls only; the component or 
components of the neutral current/voltage used to trigger 
the neutral current alarm

**NSLoggint** Neutral sensing controls only, the component or 
components of the neutral current/voltage data logged

**Hi VoltOvr** The High-Voltage Override value for the present season

**Hi VoltTime** The High-Voltage Override Time setting for the present 
season

**Lo VoltOvr** The Low-Voltage Override value for the present season

**Lo VoltTime** The Low-Voltage Override Time setting for the present 
season

various Setpoint values for the present season’s control strategy
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Table 3. Alarm LCD Screens
Display Meaning

**Volt Sensor Err** The voltage sensor is reading outside its range or may 
be faulty .

**Temp Sensor Err** The temperature sensor is reading outside its range or 
may be faulty .

**Neutral Sens Err** Neutral-sensing controls only, this message is displayed 
before the control locks out the bank following a Neutral 
Current or Neutral Voltage alarm .

**Neutral Sens Lockout** Neutral-sensing controls only, the level of neutral current 
or neutral voltage has caused the control to lock out the 
bank . See Instruction Sheet 1023-530, “S&C IntelliCap® 
Plus Automatic Capacitor Control: Setup” for more 
information .

**HiLoVoltBand Err** The Bank Voltage Change + Margin value is greater 
than the difference between the High Voltage Override 
setpoint and the Low Voltage Override setpoint .

**HiLoVoltLockout** The control has locked out the bank because of the 
High/Low-Voltage Band error .

**ZeroNeut SensErr** Neutral-sensing controls only, the control detected zero 
neutral current or neutral voltage for the length of the 
Zero Neutral Detection setpoint . See Instruction Sheet 
1023-530, “S&C IntelliCap® Plus Automatic Capacitor 
Control: Setup” for more information .

**Load Fuse Alarm** The load fuse on the faceplate is blown .
A blown load fuse will be alarmed by all wiring options 
except “-J67 .” For “-J67,” any type of station power, even 
dc, could be used as wetting voltage, so the sensing 
input is wired to control power and will not go off if the 
load fuse is blown . For all other wiring options, the 
sensing input is wired to the load side of the load fuse, 
and the alarm will be set for a blown load fuse .

Alarms
When any alarms are active, the LCD screen displays **ACTIVE ALARMS** on the top 
line. Scroll through the alarms displayed on the bottom line of the LCD screen using 
the NEXT button. See Table 3.

To clear a Neutral Sensing Lockout condition, press the faceplate ENTER button 
when the bottom line of the LCD display shows **Ent=RstNSLociout**. If any alarms 
are still active, the top line displays **ACTIVE ALARMS**. Otherwise, the LCD screen 
displays **UNIT OK** and scrolls real-time data.
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Control Software S&C capacitor controls are entirely software-driven. Each capacitor control is shipped 
with control software and IntelliLink Setup Software, both of which can be downloaded 
from the S&C Automation Customer Support Portal.

The control software is preloaded into the capacitor control at the factory. This  
software manages control functions. It continually monitors:

• Voltage, current, and/or neutral current/neutral voltage on the feeder

• Incoming SCADA commands

• State of the faceplate LEDs and buttons

• Ambient temperature at the control

• Internal clock/calendar

• Software setpoint values

• Various other setpoints and data values as needed

Based on this information, the control software decides how to respond to a change in 
voltage, a command from the faceplate or SCADA master station, and other conditions.

The control software, the setpoint values, and historical data are all stored in non-
volatile switch control memory. This memory survives power interruptions, including 
complete loss of the battery system.

IntelliLink® Setup 
Software

The IntelliLink Setup Software can be downloaded at the S&C Automation Customer 
Support Portal and runs on IBM/PC-compatible computers. This software allows 
communication with the control while at the capacitor control site. Using the IntelliLink 
Setup Software, one can:

• Change control strategies (for example, from Temperature to Time-Biased Voltage)

• Enter installation-dependent operating parameters (setpoints), such as a network 
address, the temperature-change time threshold, a voltage-override level, etc

• Monitor real-time data, such as the present line voltage and current

• Examine the performance and operating history of an installed capacitor control

• Transfer all configuration, operating, and historical data from the capacitor control 
to a report file on your computer

• Download new control software into the capacitor control

• Troubleshoot assorted types of capacitor control installation problems

SCADA 
Communication 
Equipment

Most communication equipment can be mounted inside the capacitor control enclosure 
on the back of the door. This eliminates pole clutter and provides a high level of reliability 
for the overall installation.

DNP 3.0 is the standard protocol for the IntelliCap Plus capacitor control; other  
protocol options are also available.

For more information, see Instruction Sheet 1023-561, “S&C IntelliCap® Plus  
Automatic Capacitor Control: DNP Points List and Implementation,” or contact  
S&C Electric Company.
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Capacitor Control Operation

This section explains how the capacitor control components work together to control 
the capacitor bank.

Signal Processing
The capacitor control reports voltage, current, and phase-related data in units of volts, 
amperes, kvars, kW, and kVA. The rated accuracy of these measurements is based on the 
combined accuracy of all the control components (exclusive of the sensor and sensor 
cable but inclusive of all sensor conditioning components).

Voltage readings are accurate for all distribution voltages. For var controls, phase-
angle detection requires a minimum current of 0.5% of full-scale values. Current 
magnitudes are still detected and displayed below the 0.5% threshold. The capacitor 
control uses the phase-angle offset values to calculate all ac waveform data sampled 
from the line sensor.

RMS Ac Displayed and Recorded Values
For real-time, steady-state monitoring and data logging, the capacitor control collects 
data at 0.3-second intervals. It then averages four samples and reports the 1.2-second 
averaged value. This results in a net response time of 1.2 seconds.

The capacitor control uses these 1.2-second averaged values for the real-time display, 
reporting via the faceplate, SCADA communication, and most data logging. Daily highs 
and lows are the highest and lowest raw sample (unaveraged) values; they are kept for 
the present day and the preceding 31 days.

The capacitor control also uses the 1.2-second averaged values to create interval 
averaged values (data averaged over the logging interval) for voltage and temperature, 
as well as current, kvars, power factor, kW, and neutral current/neutral voltage, if 
applicable. Choose a data-logging interval of 1, 5, 10, 15, 30, or 60 minutes. The period of 
logged interval averaged values depends on the interval chosen. See Table 5 on page 33.

The capacitor control logs the RMS value of voltage and current.

Bank switching is based on voltage and current measurements on the fundamental  
frequency and is not affected by harmonics.

Neutral current switching is also based on the fundamental frequency and is not  
affected by harmonics. The capacitor control logs the fundamental component of the 
neutral current.

Phase Angle Measurements
Var controls calculate the phase angle between the voltage and current waveforms. 
Phase-angle measurements have a 0-360 degree range.

As part of the capacitor control setup, enter an Installation Phase Offset angle 
setpoint to compensate for various installation-dependent phase-angle errors.

Data Acquisition

Control Strategies IntelliCap Plus Automatic Capacitor Controls can switch the capacitor bank 
automatically using a variety of control strategies: Temperature, Timeclock, 
Timeclock with Temperature Override, Voltage Only, Time-Biased Voltage, Time-
Biased Temperature, Automatic Offline, or Automatic Online. Var controls have 
four additional control strategies: Current, Current with Temperature Override, 
Var, and Var with Temperature Override. These are all explained in this section. 
For information about using the faceplate buttons to enable the Automatic Operation 
mode, see the “Switching the Capacitor Bank” section on page 30.
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Control Operation

The capacitor control switches the bank based on a prioritized set of conditions. 
These conditions, from highest to lowest priority, are:

• 5-minute reclose block—After opening the capacitor bank, the capacitor  will not 
reclose it for 5 minutes. This allows the capacitors to discharge. The bottom line of 
the LCD screen  shows the time remaining until the control can switch the bank in. 
The time remaining also appears in the Reclose Block field on the Operation screen.

• State of the faceplate LED displays—When the MANUAL LED display is lit, the  
capacitor control blocks automatic operation of the capacitor bank. One can only 
operate the bank from the faceplate CLOSE and OPEN buttons or the Operation 
screen when the LOCAL LED is also lit.

• Remote commands—When the REMOTE LED is lit, the capacitor control accepts 
commands from the SCADA master station.

• Anti-cycling limit—When the capacitor control is in Automatic mode, the  
Maximum Automatic Control Cycles Per Day setpoint, noted on Page 2 of the 
Setup>General screen, determines the maximum number of automatic switching 
cycles per calendar day. When this limit is reached, the capacitor bank remains 
switched out until the next calendar day.

• High and low voltage override setpoints—If the voltage remains outside the nor-
mal range for a specified period of time, the capacitor control switches the bank. See 
the Setup>General screen setpoints in Instruction Sheet 1023-530, “S&C IntelliCap® 
Plus Automatic Capacitor Control: Setup,” for more information.

• Present control strategy—The capacitor control switches the bank according to 
the control strategy presently in effect.

When the capacitor control has been in Manual mode and is returned to Automatic 
mode, it waits 60 seconds before switching the bank. This allows the operator to step 
away from the bank.

Temperature Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in  
Temperature mode, it switches the capacitor bank based on the present air  
temperature. The capacitor control can operate in both High- and Low-Temperature 
modes. It uses the following logic to determine when to switch the capacitor bank:

• The capacitor control monitors the present air temperature.

• When the capacitor control senses that the temperature has passed the Tempera-
ture at Which Bank Switches In setpoint (or the Temperature at Which Bank 
Switches Out setpoint), it starts the High/Low Temperature Change Time 
Threshold timer. This is true for either High-Temperature or Low-Temperature 
operation.

• For High-Temperature operation, when the temperature remains continuously 
above the Temperature at Which Bank Switches In setpoint for the duration of 
the timer, the control switches the bank in. When it remains below the Temperature 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

• For Low-Temperature operation, when the temperature remains continuously 
below the Temperature at Which Bank Switches In setpoint for the duration of 
the timer, the control switches the bank in. When it remains above the Temperature 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.
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Note: The voltage must remain in a range where switching the capacitor bank will not 
cause a Voltage Override condition. Otherwise, to avoid excess cycling the control 
will not switch the bank. See the “Voltage Override Operation” section in Instruction 
Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more 
information.

Note: A bad temperature sensor does not prevent the control from operating. It will 
still switch the bank if a Voltage Override condition becomes active.

Time-Biased Temperature Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in Time-
Biased Temperature mode, it switches the capacitor bank based on two sets of 
temperature setpoints. The Time-Biased Temperature strategy uses the same logic 
as the Temperature strategy, except:

• There is only one set of temperature setpoints in use.

• The capacitor bank is offline during unscheduled times.

Note: If the bank was online when the unscheduled period began and the temperature 
does not go beyond the switch-out value, the bank switches back in at the start of the 
next scheduled period. It does not wait for the temperature to go beyond the switch-in 
value.

For example: The bank is set to switch in at 80°F (27°C ) and switch out at 70° F  (21°C ). 
The timeclock scheduled period is “8:00 – 17:00.” On Monday at 17:00, the bank switches out. 
During the unscheduled time, the temperature does not go below 70° F for the length of the  
Temperature Time Threshold setpoint. On Tuesday at 8:00, the bank switches in 
again, even if the temperature is below 80° F.

Note: The voltage must remain in a range where switching the capacitor bank will not 
cause a Voltage-Override condition. Otherwise, to avoid excess cycling the control 
will not switch the bank. See the “Voltage Override Operation” section in Instruction 
Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more 
information.

Note: A bad temperature sensor does not prevent the control from operating. It will 
still switch the bank when a Voltage-Override condition becomes active.

Timeclock Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in Timeclock 
mode, it switches the capacitor bank based on a time schedule. Enter up to two different 
time schedules. The capacitor control uses the following logic to determine when to 
switch the capacitor bank:

• The capacitor control checks to see whether the present time falls within one of the  
scheduled on periods.

• When the present time is within a scheduled-on period and the calendar day is not 
a holiday, the capacitor control switches the bank in. If the bank is already active, 
it remains active.

• When the time is no longer in a scheduled-on period or the calendar day becomes a 
holiday, the capacitor control switches the bank out. If the bank is already inactive, 
it remains inactive.

Note: The voltage must remain in a range where switching the capacitor bank will not 
cause a Voltage-Override condition. Otherwise, the capacitor control will not switch 
the bank. See the “Voltage Override Operation” section in Instruction Sheet 1023-530, 
“S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more information.

Control Operation
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Timeclock with Temperature Override Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in 
Timeclock with Temperature Override mode, it switches the capacitor bank based 
on a time schedule. Enter up to two different time schedules. The control uses the  
following logic to determine when to switch the capacitor bank:

• The capacitor control checks to see whether the present time falls within one of the  
scheduled on periods.

• If the present time is within a scheduled-on period and the calendar day is not a  
holiday, the capacitor control switches the bank in. If the bank is already active, it 
remains active.

• When the time is no longer in a scheduled-on period or the calendar day becomes a 
holiday, the capacitor control switches the bank out. If the bank is already inactive, 
it remains inactive.

• When the capacitor control senses that the air temperature has passed the Tem-
perature at Which Bank Switches In setpoint (or Temperature at Which Bank 
Switches Out setpoint), it starts the High-/Low-Temperature Change Time 
Threshold timer. This is true for either High-Temperature or Low-Temperature 
operation.

• For High-Temperature operation, when the temperature remains continuously 
above the Temperature at Which Bank Switches In setpoint for the duration of 
the timer, the capacitor control switches the bank in. If it remains below the Tem-
perature at Which Bank Switches Out setpoint for the duration of the timer, the 
capacitor control switches the bank out.

• For Low-Temperature operation, when the temperature remains continuously below 
the Temperature at Which Bank Switches In setpoint for the duration of the timer, 
the capacitor control switches the bank in. If it remains above the Temperature 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage-Override condition. Otherwise, the capacitor control will not 
switch the bank to avoid excess cycling. See the “Voltage Override Operation” section 
in Instruction Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: 
Setup,” for more information.

Voltage Only Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in Voltage 
Only mode, it switches the capacitor bank based solely on the High- and Low-Voltage 
setpoints. One can also choose the preferred capacitor bank position. The control uses 
the following logic to determine when to switch the capacitor bank:

The capacitor control monitors the voltage. When the voltage remains within the  
normal range, the capacitor control switches the bank based on the Preferred  
Capacitor Bank Position setpoint on the Setup>Voltage Only Strategy screen. No 
action is taken if the Don’t Care setpoint is selected or if switching the bank would 
cause a voltage override condition.

Figures 3 and 4 on page 18 and Figure 5 on page 19 show when the capacitor bank 
switches for each setting of the Preferred Capacitor Bank Position mode. The 
capacitor control uses the Voltage Override and the Bank Voltage Change + Margin 
setpoints to avoid excess cycling.

• When the capacitor control senses that the voltage has passed the High-Voltage 
Override Value setpoint (or Low-Voltage Override Value setpoint), it starts the 
High-Voltage Override Time (or Low-Voltage Override Time) timer.

• When the voltage remains continuously above the High-Voltage Override Value 
setpoint for the duration of the High-Voltage timer, the capacitor control switches 
the bank out. When it remains continuously below the Low-Voltage Override Value 
setpoint for the duration of the Low-Voltage timer, the capacitor control switches 
the bank in.

Control Operation
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Figure 3. Voltage control switching (no preferred capacitor bank position).

Figure 4. Voltage control switching (preferred capacitor bank position is Online).

Control Operation



  S&C Instruction Sheet 1023-540  19

Figure 5. Voltage control switching (preferred capacitor bank position is Offline).

Time-Biased Voltage Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in  
Time-Biased Voltage mode, it switches the capacitor bank based on two sets of  
High-Voltage and Low-Voltage setpoints. The Time-Biased Voltage strategy uses 
the same logic as the Voltage-Only strategy, except:

• Voltage setpoints are different for scheduled and unscheduled times.

• There is only one Voltage-Change Time threshold.

• The capacitor control does not use the Preferred Capacitor-Bank Position 
setpoint.

Automatic Offline Control Strategy
When Automatic Operation mode is enabled and the capacitor control is in Auto-
matic Offline mode, the capacitor bank is always switched out. The capacitor control 
does not even switch the bank for a Voltage-Override condition.

When switching the bank online in Manual mode, the capacitor control switches it 
back offline when it returns to the Automatic Operation mode after the 60-second 
safety delay.

Automatic Online Strategy
When Automatic Operation mode is enabled and the capacitor control is in  
Automatic Online mode, the capacitor bank is always switched in. The control does 
not even switch the bank for a Voltage-Override condition.

When switching the bank offline in Manual mode, the capacitor control switches it 
back online when it returns to the Automatic Operation mode after the safety delay.

Current Control Strategy (var controls only)
When Automatic Operation mode is enabled and the capacitor control is in Current 
mode, it switches the capacitor bank based on measured single-phase current flow. The 
control uses the following logic to determine when to switch the capacitor bank:

• The capacitor control monitors the single-phase line current.

• When the capacitor control senses the current has passed the Single-Phase Amps 
at Which Bank Switches In setpoint (or the Single-Phase Amps at Which Bank 
Switches Out setpoint), it starts the Current-Change Time Threshold timer.

Control Operation
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• When the single-phase current remains continuously above the Single-Phase Amps 
at Which Bank Switches In setpoint for the duration of the timer, the control 
switches the bank in. When it remains continuously below the Single-Phase Amps 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage-Override condition. Otherwise, to avoid excess cycling, the 
capacitor control will not switch the bank. See the “Voltage Override Operation” 
section in Instruction Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor 
Control: Setup,” for more information.

Current with Temperature Override Control Strategy (var controls 
only)
When Automatic Operation mode is enabled and the capacitor control is in  
Current with Temperature Override mode, it switches the capacitor bank based on 
measured single-phase current flow. The capacitor control uses the following logic to 
determine when to switch the capacitor bank:

• The capacitor control monitors the single-phase line current.

• As soon as the capacitor control senses that the current has passed the  
Single-Phase Amps at Which Bank Switches In setpoint (or the Single-Phase 
Current at Which Bank Switches Out setpoint), it starts the Current Change 
Time Threshold timer.

• When the single-phase current remains continuously above the Single-Phase Amps 
at Which Bank Switches In setpoint for the duration of the timer, the capacitor 
control switches the bank in. If it remains continuously below the Single-Phase 
Amps at Which Bank Switches Out setpoint for the duration of the timer, the 
capacitor control switches the bank out.

• When the capacitor control senses that the air temperature has passed the  
Temperature at Which Bank Switches In setpoint (or the Temperature at Which 
Bank Switches Out setpoint), it starts the High-/Low-Temperature Change Time 
Threshold timer. This is true for either High-Temperature or Low-Temperature 
operation.

• For High-Temperature operation, if the temperature remains continuously above 
the Temperature at Which Bank Switches In setpoint for the duration of the timer, 
the capacitor control switches the bank in. If it remains below the Temperature 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

• For Low-Temperature operation, if the temperature remains continuously below 
the Temperature at Which Bank Switches In setpoint for the duration of the 
timer, the control switches the bank in. If it remains above the Temperature at 
Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage-Override condition. Otherwise, to avoid excess cycling, the 
capacitor control will not switch the bank. See the “Voltage Override Operation” 
section in Instruction Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor 
Control: Setup,” for more information.

Control Operation



  S&C Instruction Sheet 1023-540  21

Var Control Strategy (var controls only)
When Automatic Operation mode is enabled and the capacitor control is in 
Var mode, it switches the capacitor bank based on calculated three-phase kvars,  
kilovolt-amperes, reactive. The capacitor control uses the following logic to determine 
when to switch the capacitor bank:

• The capacitor control monitors the 3-phase kvar level.

• When the capacitor control senses that the kvars have passed the 3-Phase kvars at 
Which Bank Switches In setpoint (or the 3-Phase kvars at Which Bank Switches 
Out setpoint), it starts the Var Change Time Threshold timer.

• When the 3-phase kvar level remains continuously above the 3-Phase kvars at 
Which Bank Switches In setpoint for the duration of the timer, the capacitor 
control switches the bank in. If it remains continuously below the 3-Phase kvars 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will not 
cause a Voltage-Override condition. Otherwise, to avoid excess cycling the control 
will not switch the bank. See the “Voltage Override Operation” section in Instruction 
Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more 
information.

Var with Temperature Override Control Strategy (var controls only)
When Automatic Operation mode is enabled and the capacitor control is in Var with 
Temperature Override mode, it switches the capacitor bank based on calculated 
three-phase kvars, kilovolt-amperes, reactive. The capacitor control uses the following 
logic to determine when to switch the capacitor bank:

• The capacitor control monitors the 3-phase kvar level.

• As soon as the capacitor control senses that the kvar level has passed the 3-Phase 
kvars at Which Bank Switches In setpoint (or the 3-Phase kVARs at Which 
Bank Switches Out setpoint), it starts the Var Change Time Threshold timer.

• If the 3-phase kvar level remains continuously above the 3-Phase kvars at Which 
Bank Switches In setpoint for the duration of the timer, the capacitor control 
switches the bank in. If it remains continuously below the 3-Phase kvars at Which 
Bank Switches Out setpoint for the duration of the timer, the control switches the 
bank out.

• When the capacitor control senses that the air temperature has passed the  
Temperature at Which Bank Switches In setpoint (or the Temperature at Which 
Bank Switches Out setpoint), it starts the High-/Low-Temperature Change Time 
Threshold timer. This is true for either High-Temperature or Low-Temperature 
operation.

• For High-Temperature operation, when the temperature remains continuously 
above the Temperature at Which Bank Switches In setpoint for the duration 
of the timer, the capacitor control switches the bank in. If it remains below the  
Temperature at Which Bank Switches Out setpoint for the duration of the timer, 
the capacitor control switches the bank out.

• For Low-Temperature operation, if the temperature remains continuously below the  
Temperature at Which Bank Switches In setpoint for the duration of the timer, 
the capacitor control switches the bank in. If it remains above the Temperature 
at Which Bank Switches Out setpoint for the duration of the timer, the capacitor 
control switches the bank out.

Note: The voltage must remain in a range where switching the capacitor bank will 
not cause a Voltage-Override condition. Otherwise, to avoid excess cycling the 
capacitor control will not switch the bank. See the “Voltage Override Operation” 
section in Instruction Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor 
Control: Setup,” for more information.

Control Operation
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Current Sensor Location and Reverse Current Flow
For var controls, the preferred location of the current sensor is on the source side 
of the capacitor bank. This lets the sensor measure the effect of the bank when it is 
online. However, the capacitor control can still account for the effect of the bank when 
the sensor is on the load side. This is particularly useful if abnormal circuit switching 
reverses the direction of power flow, flipping the relative position of the sensor.

When a reverse-current flow condition exists, the value of the Reverse-Current  
Strategy setpoint determines how the control responds. The Adj. Var setting is the 
default.

• Adj. VAR—During a reverse-current condition, if the current sensor is on the normal 
source side, the control calculates the Adjusted 3-Phase Kars level by subtracting the 
3-Phase Bank Size setpoint from the Measured 3-Phase Kvars value. See the “Setup: 
Site-Related screen” section in Instruction Sheet 1023-530, “S&C IntelliCap® Plus  
Automatic Capacitor Control: Setup.” When the current sensor is on the normal load 
side, the control uses the measured kvars.

• Trip & Inh.—The capacitor control switches the bank offline during a reverse-current  
condition and inhibits further switching until the condition clears.

• Volt Only—During a Reverse-Current condition, the capacitor control switches the 
bank based only on the presently active Normal and Emergency Voltage Override 
setpoints. When any neutral sensor strategies are enabled, they remain in effect.

• When the capacitor control is in one of the Current or Var control modes 
when the current reverses, the Volt Only logic takes precedence over the 
High-/Low-Band Error logic; if applicable, temperature override is also 
discontinued. When current f low returns to normal, the capacitor control 
returns to switching the bank based on its regular control strategy and the  
present conditions, including the Bank Voltage Change + Margin setpoint previ-
ously in use; this value does not change while the current is reversed.

• When the capacitor control is not in one of the Current or Var control modes when the  
current reverses, it uses the High-/Low-Band Error logic in effect.

Figure 6 on page 23 shows the four possible combinations of the current sensor 
location and direction of current flow.

Sensor Location

Control Operation
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Figure 6. Current sensor location and direction of current flow combinations.

(a) Sensor on Normal Source Side with Normal Current Flow

The kvar level measured at the sensor location already reflects the effect of 
the bank. The Adjusted 3-Phase kvars setpoint equals the Measured 3-Phase 
kvars value.

(b) Sensor on Normal Source Side with Reverse Current Flow

Abnormal circuit switching has caused the current direction to reverse. In 
this case, the effect of the bank is not reflected in the measured kvars at the 
sensor location. The control calculates the Adjusted 3-Phase kvars value by 
subtracting the 3-Phase Bank Size setpoint on the Setup>Site-Related screen 
from the Measured 3-Phase kvars value.

For example: An online 1200-kvar capacitor bank is set to switch out at -750 kvar. 
The sensors are on the source side and current flow is reversed. When the load at the 
sensor location is 450 kvar, the Adjusted 3-Phase kvars setpoint is 450 - 1200 = -750 
kvar and the bank switches out.

Control Operation
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(c) Sensor on Load Side with Normal Current Flow

This occurs when the current sensor is on the load side of the bank or if 
permanent circuit switching causes the sensor to be on the load side of the bank. 
See the section “B. Sensor on Normal Source Side with Reverse Current Flow” 
on page 23.

(d) Sensor on Load Side with Reverse Current Flow

See (a) “Sensor on Normal Source Side with Normal Current Flow” section  
on page 23.

The Neutral Current Sensing option allows the capacitor control to monitor and 
take action on abnormal levels of current flowing from the starpoint of a grounded, 
wye-connected bank to the system neutral and/or ground. See Figure 7. The sensed 
current is the vector sum of the three capacitor phase currents plus harmonic currents. 
Factors contributing to neutral current include:

• Unequal capacitance between phases of the capacitor bank (This may result from  
manufacturing tolerances or the partial failure of individual capacitor units.)

• A voltage imbalance between individual phases of the distribution circuit

• Harmonic distortion of the line current (A variety of sources can cause harmonic  
distortion, such as lightning, welding, solid state variable-speed drives, and equip-
ment using switching power supplies.)

• The opening or disconnection of one or two phases of the capacitor bank due to a 
blown fuse, a failed switch, or defective wiring

The capacitor control can be configured to detect abnormal levels of neutral current 
and generate alarms, both in Automatic mode and in Manual mode. If desired, a capacitor  
control in Automatic mode can also take appropriate corrective action. See the 
Setup>Neutral Sensor screen section in Instruction Sheet 1023-530, “S&C IntelliCap® 
Plus Automatic Capacitor Control: Setup,” for more information. Maintenance personnel 
can then diagnose and correct the identified problem.

   WARNING
The individual capacitor units retain a high-voltage charge for several minutes 
after they are disconnected and must be short circuited and grounded prior to 
running tests . Only trained personnel should clear and test the capacitors .

Neutral Current 
Detection

A phase

Starpoint

To capacitor control
0-10 Vac

B phase

C phase

Neutral

Fuses

Switches

Neutral current sensor
(CT terminated on an
imbedded resistor)

Figure 7. The neutral current sensor and a wye-connected bank with a starpoint.
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The capacitor control uses the following logic to determine when to trigger the 
Neutral Current alarm:

• The capacitor control monitors current flowing between the starpoint and the  
system neutral and ground.

• When the capacitor control senses that current flow has exceeded the Neutral 
Current Alarm Level setpoint, it starts the Neutral Current Change Time 
Threshold timer.

• If the neutral current remains continuously above the setpoint for the duration of 
the timer, the capacitor control takes one of the following actions:

When the Neutral Current Corrective Action setpoint is disabled, the  
control displays error messages on the Operation and Alarm Status screens and 
**ACTIVE ALARMS** on the LCD screen. Automatic control operation is disabled until 
someone clears the alarm from the faceplate or from the Alarm Status screen.

When the Neutral Current Corrective Action setpoint is enabled and there was 
no recent switching activity, the capacitor control takes the bank offline, if it is not 
already offline. The capacitor control displays error messages on the Operation and 
Alarm Status screens and **ACTIVE ALARMS** on the LCD screen. Automatic Opera-
tion mode is disabled until someone clears the alarm from the faceplate or from the 
Alarm Status screen.

When the Neutral Current Corrective Action setpoint is enabled and there was 
recent switching activity, the capacitor control tries to reverse the last action after the 
reclose block, if applicable.

When Neutral Current Retry mode is also enabled, the capacitor control oper-
ates the bank again. If the neutral current level is normal, the alarms clear and the  
capacitor control returns to normal operation. Otherwise, the capacitor control returns 
the bank to the Corrective Action state. Further automatic operation of the bank is 
blocked until someone clears the alarm from the faceplate or from the Alarm Status 
screen. The capacitor control displays error messages on the Operation and Alarm 
Status screens, and **ACTIVE ALARMS** on the LCD screen.

When Neutral Current Retry mode is disabled, the capacitor control blocks  
further automatic operation of the bank after the corrective action. The capacitor  
control displays error messages on the Operation and Alarm Status screens and 
**ACTIVE ALARMS** on the LCD screen. Automatic Operation mode is disabled 
until someone clears the alarm from the faceplate or from the Alarm Status screen.

Note: When a switch-out attempt triggers the Neutral Current alarm and the 
Neutral Current Corrective Action setpoint is enabled, the capacitor control switches 
the bank back online in case one of the bank switches did not operate correctly. The 
capacitor control does this to avoid system imbalances caused by only some of the 
phases being online.

• When the control detects zero neutral current for a period of time specified by the 
Zero Neutral Current Detection setpoint (if enabled), it sets the Zero Neutral 
Current alarm. The capacitor control does not try any corrective action or lock out 
the bank. The alarm clears when the Zero Neutral Current condition clears or 
when a lockout reset procedure is performed.

• The user may select whether the capacitor control alarms on the fundamental (60-Hz)  
component of the neutral current or on the Total RMS value. The user may also 
select whether the control logs fundamental or Total RMS data values.

NOTICE
Do not enable Automatic Operation mode until clearing the condition that 
triggered the Neutral Current alarm .

If trying to reset the alarm and the condition is still present, the alarm messages 
become active again .

Control Operation
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The Neutral Voltage Sensing option allows the capacitor control to monitor and 
take action if it detects abnormal levels of voltage on the starpoint of an ungrounded, 
wye-connected bank. See Figure 8. The sensed voltage is the vector sum of the three 
capacitor phase voltages plus harmonic voltages. Factors contributing to neutral volt-
age include: 

• Unequal capacitance between phases of the capacitor bank (This may result from  
manufacturing tolerances or the partial failure of individual capacitor units.)

• A voltage imbalance between individual phases of the distribution circuit

• Harmonic distortion of the line voltage (A variety of sources can cause harmonic 
currents, which can cause harmonic voltage distortion. Examples include lightning, 
welding, solid state variable speed drives, and equipment using switching power 
supplies.)

• The opening or disconnection of one or two phases of the capacitor bank due to a 
blown fuse, a failed switch, or defective wiring

 One can configure the capacitor control to detect abnormal levels of neutral voltage 
and generate alarms, both in Automatic mode and in Manual mode. If desired, a capac itor  
control in Automatic mode can also take appropriate corrective action. See the “Setup: 
Neutral Sensor screen” section in Instruction Sheet 1023-530, “S&C IntelliCap® Plus  
Automatic Capacitor Control: Setup,” for more information. Maintenance personnel 
can then diagnose and correct the identified prob lem.

   WARNING
The individual capacitor units retain a high-voltage charge for several minutes 
after they are disconnected and must be short circuited and grounded prior to 
running tests . Only trained personnel should clear and test the capacitors .

Neutral Voltage 
Detection

Figure 8. Neutral voltage sensor and wye-connected bank with starpoint.

Control Operation
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The capacitor control uses the following logic to determine when to trigger the 
neutral voltage alarm:

• The capacitor control monitors the voltage between the starpoint and ground.

Note: Neutral voltage monitoring begins 5 minutes after opening the capacitor bank 
so that trapped voltages can discharge.

• As soon as the control senses that voltage has exceeded the Neutral Voltage Alarm 
Level setpoint, it starts the Neutral Voltage Change Time Threshold timer.

• When the neutral voltage remains continuously above the setpoint for the duration 
of the timer, the control takes one of the following actions:

When the Neutral Voltage Corrective Action setpoint is disabled, the control 
displays error messages on the Operation and Alarm Status screens and **ACTIVE 
ALARMS** on the LCD display. Automatic Operation mode is disabled until someone 
clears the alarm from the faceplate or from the Alarm Status screen. 

When the Neutral Voltage Corrective Action setpoint is enabled and there  
was no recent switching activity, the capacitor control takes the bank offline, if it is 
not already offline. The capacitor control displays error messages on the Operation 
and Alarm Status screens and **ACTIVE ALARMS** on the LCD screen. Automatic 
Operation mode is disabled until someone clears the alarm from the faceplate or from 
the Alarm Status screen.

When the Neutral Voltage Corrective Action setpoint is enabled and there was 
recent switching activity, the capacitor control tries to reverse the last action after the 
reclose block, if applicable.

When Neutral Voltage Retry mode is also enabled, the capacitor control operates 
the bank again. If the neutral voltage level is normal, the alarms clear and the control 
returns to normal operation. Otherwise, the capacitor control returns the bank to the  
Corrective Action state. Further automatic operation of the bank is blocked until 
some one clears the alarm from the faceplate or from the Alarm Status screen. The 
control displays error messages on the Operation and Alarm Status screens and  
**ACTIVE ALARMS** on the LCD screen.

When Neutral Voltage Retry mode is disabled, the capacitor control blocks fur-
ther automatic oper ation of the bank after the corrective action. The capacitor control 
displays error messages on the Operation and Alarm Status screens and **ACTIVE 
ALARMS** on the LCD screen. Automatic Operation mode is disabled until someone 
clears the alarm from the faceplate or from the Alarm Status screen.

Note: When a switchout attempt triggers the Neutral Voltage alarm and the Neutral 
Voltage Corrective Action setpoint is enabled, the capacitor control switches the 
bank back online in case one of the bank switches did not operate correctly. The 
control does this to avoid system imbalances caused by only some of the phases being 
on line.

• When the capacitor control detects zero neutral voltage for a period of time specified 
by the Zero Neutral Voltage Detection setpoint, if enabled, it sets the Zero Neutral  
Voltage alarm. The capacitor control does not try any corrective action or lockout 
the bank. The alarm clears when the Zero Neutral Voltage condition clears or when 
a lockout reset procedure is performed.

• The user may select whether the capacitor control alarms on the fundamental (60-Hz)  
component of the neutral voltage or on its Total RMS value. The user may also 
select whether the capacitor control data logs fundamental or Total RMS values.

NOTICE
Do not enable Automatic Operation mode until clearing the condition that 
triggered the Neutral Current alarm .

If trying to reset the alarm and the condition is still present, the alarm messages 
become active again .

Control Operation
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When the SCADA Override mode is enabled via IntelliLink software or a SCADA  
command, the SCADA master station can choose the capacitor bank state, as well as 
the voltage range in which SCADA Override mode is active. The capacitor control 
uses the following logic to determine when to switch the capacitor bank: 

• The SCADA master station sends a Close or Open request to the capacitor control.

• The control switches the bank and stays in that state for the length of the SCADA  
Override Timeout Threshold setpoint. When the setpoint is set to Latched mode, 
the control remains in that state indefinitely, except during Voltage Override condi-
tions. When the control does not receive a new SCADA Override command during 
this time period, the SCADA override ends and the capacitor control returns to its 
regular automatic control logic.

Note: The capacitor control will not switch the capacitor bank if the control is already in  
Voltage Override mode or if switching would put it into Voltage Override mode. 
When the voltage later returns to a level where switching is allowed and SCADA 
Override mode is still active, the capacitor control remembers the SCADA command 
and switches the bank.

• When the Use the Following Voltage Overrides setpoint is set to the Yes state, 
the control uses the Voltage Override values on the Setup>SCADA Override screen 
while SCADA Override mode is active. Otherwise, it uses the Voltage Override 
values for the present season.

Note: The voltage must remain in a range where switching the capacitor bank will not 
cause a Voltage Override condition. Otherwise, the capacitor control will not switch 
the bank to avoid excess cycling. See “Voltage Override Operation” in Instruction 
Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more 
information.

SCADA Override 
Strategy

Review the voltage and/or var values before and after switching in the Voltage Levels 
During Switching and Kvar Levels During Switching screens to find possible 
switching errors. An error condition exists when the change in voltage (∆V) is less 
than the Minimum Percentage of Average Delta Voltage setpoint over the last four 
switching operations or when the change in kvars (∆kvar) is less than the Minimum 
Percentage of Average Delta kvars setpoint over the last four switching operations. 
These percentages are set on Page 2 of the Setup>General screen.

When the average ∆V is at least 0.80 V, then the capacitor control can use ∆V to detect 
errors. When current sensors are on the source side of the bank, then it can use ∆kvar. 
When conditions are favorable for both methods, the capacitor control uses ∆V and 
∆kvar and flags an error only when they agree that an error occurred. When conditions 
are favorable for one method only, the control uses that method to flag errors.

Note: For error-detection analysis, the capacitor control does not use the ∆V and 
∆kvar from a forced retry (an attempt to manually switch the bank into the state 
already indicated).

High-/Low-Voltage Band Error Options
One can choose how the control responds when a High-/Low-Voltage Band error occurs 
when the Bank-Voltage Change + Margin setpoint is greater than the difference 
between the High-Voltage Override Value setpoint and the Low-Voltage Override 
Value setpoint. The option presently in effect is shown in the Hi-/Lo-Band Err field 
on the Setup>Seasons screen and can be:

• Bank Lockout—When either of the Emergency-Voltage Override Time setpoints 
is disabled, the capacitor control blocks further automatic operation of the capacitor 
bank, except to open a closed bank during a High-Voltage condition.

• Change BVC+M—If both of the Emergency-Voltage Override Time 
setpoints are enabled, the capacitor control uses the emergency-voltage 
override values to define Voltage-Override conditions and to inhibit bank 

Detecting Switching 
Errors

Control Operation
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Control Operation

Table 4. Capacitor Bank Operation and Control States
Faceplate State Control Operate Bank From

AUTO/ 
MANUAL

REMOTE/ 
LOCAL

Operating 
Mode

Faceplate Operation 
Screen 

IntelliLink

SCADA 
Master 
Station

Manual Local Manual Yes Yes No

Manual Remote SCADA No No Yes

Auto Local Automatic No No No

Auto Remote Automatic No No Yes

switching. The strategy for the present season remains in effect. The capac-
itor control returns to the normal voltage override setpoints when the  
calculated Bank Voltage Change + Margin is less than the difference between the 
High-Voltage Override Value setpoint and the Low-Voltage Override Value 
setpoint for the present season. However, if it becomes greater than the difference 
between the Emergency Voltage-Override values, the capacitor control blocks 
further automatic operation of the bank, except to open a closed bank during a 
High-Voltage condition.

The state of the faceplate LEDs determines which method(s) to use to switch the 
capacitor bank in and out. Table 4 shows the possible combinations and how each 
affects the ability to operate the bank.

The following rules apply no matter which method is chosen to switch the bank:

• An energized capacitor bank cannot be reclosed for a period of 5 minutes after 
being opened. The Reclose Block feature provides time for the capacitor charge 
to bleed off. The bottom line of the LCD screen and the Reclose Block field on the  
Operation screen show the time remaining before the capacitor control can switch 
the bank in. The OPEN LED on the faceplate blinks slowly while a Reclose Block 
condition is in effect.

• One can enable the Manual Operation Delay setpoint, noted on Page 2 of the 
Setup>General screen, to add a separate switch delay (for both opening and 
closing the bank) to allow time for an operator to step away from the bank after 
pressing the CLOSE or OPEN button. When this delay is enabled, the CLOSE or 
OPEN LED starts blinking at a fast rate to indicate a pending action. The delay and 
the requested operation can be cancelled at any time before the output relays are  
energized by pressing the OPERATION MODE CHANGE button to enter Automatic 
Operation mode.

Note: If cancelling an operation manually, make sure to return to Manual mode to 
prevent the bank from switching automatically.

• The red CLOSE LED is lit when the capacitor bank switch is closed; it blinks rapidly 
while it is timing to close. The green OPEN LED is lit when the capacitor bank switch 
is open. It blinks rapidly while it is timing to open; it blinks slowly while a Reclose 
Block condition is in effect.

• When powering the capacitor control for the first time or when the capacitor con-
trol software has been reloaded (not updated), the LEDs do not indicate the bank 
state until a switching operation is performed. To make the LED displays match the 
switch condition, operate the bank manually or wait for an automatic operation to 
occur. When the capacitor control is in Manual mode and is changed to Automatic 
mode, it waits 60 seconds before switching the bank. This allows the operator to 
step away from the bank.
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Switching the Capacitor Bank

IMPORTANT: When the MANUAL and LOCAL LEDs are lit, the capacitor control 
blocks automatic and SCADA operation of the capacitor bank. Operating the bank can 
only be done from the faceplate or from the Operation screen.

To use the faceplate buttons to switch the capacitor bank in or out, confirm:

• The faceplate LCD screen shows **UNIT OK**. If the LCD screen does not show 
**UNIT OK**, see Instruction Sheet 1023-550, “S&C IntelliCap® Plus Automatic 
Capacitor Control: Troubleshooting,” for more information.

• The OPEN LED is not blinking. When the OPEN LED is blinking slowly, the Reclose 
Block condition is in effect. Wait until it stops blinking before trying to switch the 
bank.

• The MANUAL LED is lit. When the AUTO LED is lit, pressing the CLOSE or OPEN 
button has no effect.

• The LOCAL LED is lit.

Following your company’s procedures, press the CLOSE or OPEN button on the 
control faceplate to operate the capacitor bank.

• To send a Close command to the capacitor bank switch, press the CLOSE button.

• To send an Open command to the capacitor bank switch, press the OPEN button.

Local Bank Operation from the IntelliLink Software
To use the IntelliLink software to switch the capacitor bank:

On the Operation screen, confirm:

• The OPEN LED display is not blinking. When the OPEN LED is blinking slowly, the 
Reclose Block delay is in effect. Wait until it stops blinking before trying to switch 
the bank.

• The MANUAL LED is lit. When the AUTO LED is lit, commands from the Close and 
Open fields have no effect.

• The LOCAL LED display is lit.

Following your company’s procedures, click on the Close or Open field on the  
Operation screen to operate the capacitor bank.

• To transmit a Close command to the capacitor bank switch, click on the Close but-
ton. Click on the OK button in the dialog box to confirm the command.

• To transmit an Open command to the capacitor bank switch, click on the Open 
button. Click on the OK button in the dialog box to confirm the command.

Remote Bank Operation from the SCADA Master Station or  
WinMon Graphical User Interface Software
The capacitor bank can be opened or closed from a SCADA master station or with the 
WinMon Graphical User Interface software. The capacitor control must be in Remote 
Operation mode (the REMOTE LED is lit) to accept commands from the SCADA master 
station or the WinMon interface. For more information on the WinMon interface, contact 
S&C Electric Company.

Manual Operation

To enable the Automatic Operation mode, confirm the faceplate AUTO LED is lit. The 
software in the capacitor control switches the bank automatically based on the values 
entered when the capacitor control was configured. For an explanation of the available 
switching strategies, see the “Control Strategies” section on page 14. 

Automatic Operation
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Viewing Data

The data-logging screens show high and low values and trend data for voltage and current 
amplitude, phase, and related parameters. When a customer complains about a service  
outage or low voltage, the information in the data-logging screens can help determine 
what happened and why.

Except for operation counters, the data logs are shown in a browser window. Internet 
Explorer 5.0 or higher is the recommend browser for these html screens. The Intelli-
Link software opens the browser automatically when viewing logged data. To access 
the help text for these screens, using IntelliLink Setup Software in the menu, click 
on the “Help” entry, click on the “Contents” entry, and click on the software type (for 
example, PCSD---S).

Displaying the Operation Counters Screen
The Operation Counters screen shows the number of capacitor bank switching cycles 
for each day of the preceding 31 days during this calendar year and since installation. 
Each cycle consists of a Close operation and an Open operation. See Figure 9.

To open the Operation Counters screen, click on the Operation Counters button 
on any IntelliLink screen.

Routine Data Logging

Figure 9. The Operation Counters screen.

The counters record both automatic and manual switching operations. The screen 
includes the following fields:

Total This Year
This is the total number of switching cycles completed during this calendar year. The 
capacitor control updates the counters when it switches the bank out.

Note: If the capacitor control’s software is reloaded (not updated) or the Reset All Cycle  
Counters field is enabled, this counter is reset to zero.

Total Since Installation
This is the total number of switching cycles completed since installation of the capacitor 
control. The capacitor control updates the counters when it switches the bank out.

Note: If the capacitor control’s software is reloaded (not updated) or the Reset All Cycle  
Counters field is enabled, this counter is reset to zero.
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Reset All Cycle Counters
When this field is set to the Enabled state, the capacitor control clears all bank switching 
cycle counters. This is a momentary operation. Once executed, the field shows “Cleared” 
until the first switchout. The field then shows “Disabled.”

The Sensor Profiles screen shows the sensor profiles for voltage and temperature and, 
if applicable, current, power factor, kvars, kW, and neutral current or neutral voltage, 
as well as the bank state (Closed or Open). The capacitor control uses the Extended 
Data Logging Interval setpoint (noted on Page 2 of the Setup>General screen) to 
record data. See Figure 10.

Note: The Neutral Sensor values logged may be either Fundamental or Total 
RMS, which is selected using the Neutral Sensor Data Logging setpoint on the 
Setup>Neutral Sensor screen.

Displaying the Sensor Profiles screen
To display the Sensor Profiles screen, from the Data menu, choose the Event/Data 
Logs option. Then, double-click on the “Data_Logs” entry. Click on the All Sensors 
option. Then, choose which profiles to view. If desired, enter a date range for the data 
to view. Then, click on the OK button. The IntelliLink software automatically opens a 
browser window to display the data.

Note: To view the voltage profile only, click on the Voltage Profile option instead of  
the All Sensors option.

Sensor Profiles

Figure 10. The Sensor Profiles screen (var with neutral current control).

Viewing Data
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Table 5. Data-Logging Intervals for Sensor Profiles.
Data Logging Interval Days of Data Logged Record Timestamp Period

1 minute 2 days Once every 24 minutes

5 minutes 10 days Once every 2 hours

10 minutes 20 days Once every 4 hours

15 minutes 30 days Once every 6 hours

30 minutes 60 days Once every 12 hours

60 minutes 120 days Once every 24 hours

Viewing Data

The Sensor Profiles log includes data for 120 time-stamped records. Each record 
contains 24 data samples. When the log is full, each new sample overwrites the oldest 
sample in the log. The most recent sample is shown at the top of the log.

The control uses the Extended Data Logging Interval setpoint, configured on Page 
2 of the Setup: General screen, for recording these numbers, which are interval-averaged 
values. The control collects data at 0.3-second intervals. It averages four samples to 
yield the 1.2-second averaged value. Then, it adds together all the 1.2-second averaged 
values in the interval (for example, 2:46 a.m. to 3:00 a.m. for a 15-minute data-logging 
interval) and divides the total by the number of values.

The number of days of data logged depends on the interval chosen. The capacitor 
control can log data in 1-, 5-, 10-, 15-, 30-, or 60-minute intervals. Table 5 shows how 
many days of data are logged, and how often the data is timestamped for each interval.

Changing the data-logging interval, some data may be lost. The control calculates 
where the sample for the present time should appear using the new interval. It then 
logs the present sample in the correct location without clearing the entire record or 
time stamp. This means a single record could contain data using two different logging 
intervals. Make sure to note the time at which the interval changed (for use during 
later data analysis).

Note: If the capacitor control has a power outage, up to 48 hours of data can be lost. 
Whenever possible, generate all necessary reports before powering down the capacitor 
control. If bringing a capacitor control in from the field, generate all necessary reports 
as soon as possible. This minimizes the amount of lost data.

If the power fails and then returns within the time span of a single record, the control 
clears that entire record and time stamp. It then logs the present sample in the correct 
location within the record. Time stamping begins with the next record.

If the power fails and returns the same day or the next day, the capacitor control 
clears all the records (including time stamps) between the one in which the power failed 
and the one in which power was restored. It then logs the present sample in the correct 
location. Time stamping begins with the next record.

If the power fails and returns several days later, the capacitor control clears all the 
records (including time stamps) between the one in which the power failed and the end 
of that day. The next day of data in the log is for the day on which power was restored. 
This discontinuity minimizes the amount of data overwritten. The capacitor control 
clears all records up to the one in which power was restored and logs the present sample 
in the correct location. Time stamping begins with the next record.
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Users may choose the type of harmonic data the control logs: Voltage, Current, or Neu-
tral Voltage/Neutral Current, as applicable. The values are shown in the Selected Sensor 
Harmonics Analysis screen. See Figure 11.

Displaying the Selected Sensor Harmonics Analysis screen
To display the Selected Sensor Harmonics Analysis screen, from the Data menu, 
choose the “Event/Data Logs” entry. Then, double-click on the Data_Logs option. Click 
on the “Harmonics” entry. If desired, enter a date range for the data to view. Then, click 
on the OK button. The IntelliLink software automatically opens a browser window to 
display the data.

Harmonics Data

Viewing Data

Figure 11. The Selected Sensor Harmonic Analysis screen.

The capacitor control calculates the 1st (fundamental), 3rd, 5th, and 7th harmonics, 
as well as the total harmonic distortion (THD), every 15 minutes. The date and time of 
the calculated harmonics are shown as well as the sensor type logged. See the Power  
Harmonics Data Logged setpoint on the Metering screen. Once the log is full, each 
new value overwrites the oldest value in the log.

Harmonics are expressed as a percentage of the fundamental. Total harmonic  
distortion is calculated as the ratio of the total RMS harmonic content to the RMS level 
of the fundamental.

The Daily High and Low screens show the daily high and low values for a 24-hour period 
(12 midnight to 12 midnight) for Voltage and Temperature values and, if applicable, 
current, power factor, kvars, kW, and neutral current or neutral voltage. One can view the 
high/low data for today and for each of the preceding 31 days. See Figure 12 on page 35.

Displaying one of the Daily High and Low screens
To display the Daily High and Low screen, from the Data menu, choose the “Event/
Data Logs” entry. Then, double-click on the Data_Logs option. Click the type of high/
low data to view. If desired, enter a date range for the data to view. Then, click on the 
OK button. The IntelliLink software automatically opens a browser window to display 
the data.

Daily High-Low for 
Last Month
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Viewing Data

Figure 12. One of the Daily High and Low screens.

Each displayed value is the highest or lowest raw sample value for that parameter 
for the specified day. The capacitor control takes a measurement every 0.3 seconds.

A temperature sensor located on the bottom of the capacitor control enclosure 
measures external temperature.

Every time the capacitor bank switches in or out (manually or automatically), the 
capacitor control records the time, date, and request type. These values are shown on 
the Switching Events screen. See Figure 13.

Displaying the Switching Events screen
To open the Switching Events screen, from the Data menu, choose the “Event/Data 
Logs” entry. Then, double-click on the Event_Logs option. Click on the “Switching 
Events” entry. If desired, enter a date range for the data to view. Then click on the OK 
button. The IntelliLink software automatically opens a browser window to display 
the data.

Switching Events

Figure 13. The Switching Events screen.
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Viewing Data

Data for 14 complete switching cycles is included. When the log is full, each new 
event overwrites the oldest event in the log. The most recent event is always at the top 
of the list.

The Switching Events screen includes the following fields:

Date and Time
This is the date and time when the switching operation occurred.

Request Type
This is the type of request (manual, voltage override, etc.) that caused the capacitor 
bank to switch.

The Power Outages screen shows the date and time of the last 15 power cycles. See 
Figure 14.

Displaying the Power Outages screen
To display the Power Outages screen, from the Data menu, choose the “Event/Data 
Logs” entry. Then, double-click on the “Event_Logs” entry. Click on the Power Outages 
option. If desired, enter a date range for the data to view. Then, click on the OK button. 
The IntelliLink software automatically opens a browser window to display the data.

Power Outages

Figure 14. The Power Outages screen.

This log can hold information for 15 power failures and 15 power restorations. When 
the log is full, each new event overwrites the oldest event in the log. The most recent 
event is always at the top of the list.

Every time the capacitor bank switches in or out (manually or automatically), the 
control records the line voltage before and after switching, as well as the time, date, 
and request type. These values are shown in the Voltage Levels During Switching 
screen. See Figure 15 on page 37.

Displaying the Voltage Levels During Switching screen
To display the Voltage Levels During Switching screen, from the Data menu, choose 
the “Event/Data Logs” entry. Then, double-click on the “Event_Logs” entry. Click on the 
Voltage Switching Deltas option. If desired, enter a date range for the data to view. 
Then click on the OK button. The IntelliLink software automatically opens a browser 
window to display the data.

Voltage Levels  
During Switching
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Viewing Data

Figure 15. The Voltage Levels During Switching screen.

This log includes data for 14 complete switching cycles. When the log is full, each 
new event overwrites the oldest event in the log. The most recent event is always at 
the top of the list.

For the voltage measurements both before and after switching, the capacitor control 
takes a measurement every 0.3 seconds. It adds together four consecutive samples and 
divides the total by four to yield a 1.2-second averaged value. The first measurement is 
taken just before the capacitor bank switches are energized. The second measurement 
is taken approximately 3 seconds after the switches are de-energized.

Use the information on this screen to look for possible error conditions  
during switching (see the “Switching Events” section on page 35) and to check the 
switching times. It is also useful for determining the Bank Voltage Change + Margin: 
Estimated Value setpoint, on Page 1 of the Setup>General screen. When the Bank 
Voltage Change + Margin: Automatic Calculation setpoint is enabled, the capacitor 
control uses these delta values in its calculation. See the Instruction Sheet 1023-530, 
“S&C IntelliCap® Plus Automatic Capacitor Control: Setup,” for more information.

This window includes the following fields:

Date and Time
This is the date and time when the switching operation occurred.

Before
This is the line voltage before the capacitor control switched the bank.

After
This is the line voltage after the capacitor control switched the bank, approximately 
3.5 seconds after the end of a pulse.

Delta
This is the change in voltage due to switching the bank. If the bank is operating normally, 
this is a positive number when the bank is switched in and a negative number when 
the bank is switched out.
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Viewing Data

Note: Because of the way the capacitor control rounds and stores voltage values, the 
delta value displayed may be slightly different from the Before value minus the After 
value.

Request Type
This is the type of request (manual, voltage override, etc.) that caused the capacitor 
bank to switch.

For var controls, every time the capacitor bank switches in or out (manually or auto-
matically), the control records the kvar levels before and after switching, as well as the 
time, date, and request type. These values are shown in the screen. See Figure 16.

Display the Kvar Levels During Switching screen
To display the Kvar Levels During Switching screen, from the Data menu, choose 
the “Event/Data Logs” entry. Then, double-click on the “Event_Logs” entry. Click on 
the kvar Switching Deltas option. If desired, enter a date range for the data to view. 
Then, click on the OK button. The IntelliLink software automatically opens a browser 
window to display the data.

Kvar Levels  
During Switching

Figure 16. The Kvar Levels During Switching screen.

The Kvar Levels During Switching screen includes data for 14 complete switching  
cycles. When the log is full, each new event overwrites the oldest event in the log. The 
most recent event is always at the top of the list.

For the kvar measurements both before and after switching, the capacitor control 
takes a measurement every 0.3 seconds. It adds together four consecutive samples and 
divides the total by four, to yield a 1.2-second averaged value. The first measurement is 
taken just before the capacitor bank switches are energized. The second measurement 
is taken approximately 3 seconds after the switches are de-energized.

Use the information in this screen to look for possible error conditions  
during switching (see the “Switching Events” section on page 35) to check the switch-
ing times and to monitor the health of the capacitor bank.
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Viewing Data

This screen includes the following fields:

Date and Time
This is the date and time when the switching operation occurred.

Before
This is the kvar value before the capacitor control switched the bank.

After
This is the kvar value after the capacitor control switched the bank.

Delta
This is the change in kvars due to switching the bank. If the bank is operating normally, 
this is a negative number when the bank is switched in and a positive number when 
the bank is switched out.

Request Type
This is the type of request (manual, voltage override, etc.) that caused the capacitor 
bank to switch.

The Data Graphing screens provide quick access to historical data in graph form. One 
can view graphs of daily highs and lows for the last month and graphs of sensor profiles. 
See Figure 17.

The capacitor control automatically scales each graph to show as much detail as  
possible. To rescale a graph, from the Data menu select the “Graphing Options” entry. 
Deselect the Use Auto Scaling feature. Then, enter the values for the desired Y-axis 
range.

Note: To produce a continuous scale graph of the power factor from full lag to full 
lead, leading power factors are plotted from 1 to 2 (instead of -1 to 0). The rescaled 
values are calculated as their difference from 2 (for example, a leading power factor 
of -0.8 is graphed as 1.2). A value of “1” equals unity power factor (zero var).

Displaying the daily high/low graphs
Do open the Daily High/Low Graph screens, from the Data menu, click on the “Graphs” 
entry. Then, double-click on “High-Low Graphs” entry. Select the graph to view (for 
example, Figure 17). Then, click on the OK button.

Data Graphing

Figure 17. One of the Daily High/Low Graph screens.
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Viewing Data

Displaying the sensor profile graphs
To open the Sensor Profile Graph screen, from the Data menu, click on the “Graphs” 
entry. Then, double-click on the “Sensor Graphs” entry. Select the graph to view (for 
example, Voltage Profile). To move through all the graphs for the data, click on the 
First, Previous, Next, and Last buttons. See Figure 18.

Note: The amount of data in the sensor profile graphs depends on the data-logging 
interval. (See the “Sensor Profiles” section on page 32 for more details.)

Figure 18. One of the Sensor Profile Graph screens.
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Use the Report feature to save the capacitor control’s software settings and stored data 
to your computer as a CSV (comma-separated value) file. Users may keep the report as a 
permanent record and use the report data in spreadsheets or other types of programs.

Follow these steps to save control data in a CSV file:

STEP  1.  Connect a portable computer to the capacitor control and start the IntelliLink 
software. 

STEP  2.  From the Data menu, choose the Reports option.

STEP  3.  In the dialog box, select the type of report to generate. Then, click on the OK 
button.

There are four report types: 

Full—Includes all the information contained in the capacitor control

System Setup and Operation—Contains the configuration data for the 
capacitor control

Troubleshooting Information—Contains the information recorded in 
the troubleshooting logs

Historical Data—Contains the daily statistics, the sensor profiles, the 
switching data, and the log of power outages

STEP  4.  In the Save Report dialog box, specify a name and location for this report, and 
then click on the OK button.

If the file location is not specified, the file is saved to the same directory 
as the program files for this for this type of control (for example, the default  
location for PCSD1--S report files is C:\ELINE\PCSD---S\). The extension “.CSV” is added 
automatically. When the report is complete, the message “Task completed” appears on 
the status line of the Writing Report dialog box.

Generating Reports
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Setup Configurations

If several capacitor controls use a similar setup configuration, the configuration file 
can be saved from one control and loaded it into the others replicating the saved 
configuration. Specific setpoints can then be manually adjusted in each control.

A configuration file should be used with control software that is the same revision as 
the software used to create the configuration file. However, a file created by a different 
software revision can be used. Software revisions can add setpoints for new features. 
If the configuration file was created with older software, only the setpoints available 
in the older software will be configured, and setpoints for new features will be set to 
the default value. If the configuration file was created by newer software, setpoints not 
present in the target control will not be added by the configuration file.

Refer to Table 6. Configuration files are compatible between software revisions 115 
through 118; however, these features were added or revised for software revision 116:

Table 6. Instruction Sheet References for Various Features
Feature Reference Page

Optional second neutral current retry 1023-530 pg 49

Optional second neutral voltage retry 1023-530 pg 52

First and second neutral current retry changed from Enable mode to a time 
value selectable from 0 to 48 hours

1023-530 pg 49

First and second neutral voltage retry changed from Enable mode to a time 
value selectable from 0 to 48 hours

1023-530 pg 52

Neutral Sensing alarm method is user-selectable: Fundamental harmonic or 
total RMS

1023-530 pgs 50 
& 53

Neutral-sensing data logging is user-selectable: Fundamental harmonic or total 
RMS

1023-530 pgs 50 
& 53

Default harmonics calculation method changed from IEEE to IEC 1023-550 pg 22

SCADA Override Time-Out setpoint changed from 3-hour increments to 1-hour 
increments above the 1-hour setting

1023-530 pg 54

Saving a Setup 
Configuration

Follow these steps to save a setup configuration:

STEP  1.  Determine which capacitor control contains the configuration being saved.

STEP  2.  Connect a computer to the selected control and start the IntelliLink software.
For details, see the “Start IntelliLink Software” section in Instruction Sheet 
1023-530, “IntelliCap® Plus Automatic Capacitor Control: Setup.” If the 
computer is already connected to the capacitor control, skip this step.

STEP  3.  Click on the Save Data button (from most IntelliLink software screens).
Another option is to click on “Save Setpoints” entry in the File menu. Then, 
click on the OK button.

STEP  4.  In the Save Setpoints dialog box, specify a name and location for this 
configuration file. Then, click on the Save button. If the file location is not 
specified, the file is saved to the same directory as the program files for this 
type of control (for example, the default location for PCSD1--S report files is 
C:\ELINE\PCSD---S\). The extension “.CFG” is added automatically. 

Note: This process does not save the “Physical Location” entry (configured on 
Page 2 of the Setup>General screen) or the “Communications RTU Address” entry 
(configured on Page 1 of the Communications>Setup screen).
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Setup Configurations

Loading a Saved 
Configuration

Follow these steps to load a saved configuration:

STEP  1.  Connect a computer to the control where the configuration will be loaded. 
Then, start the IntelliLink software.

For details, see the “Start IntelliLink Software” section in Instruction Sheet  
1023-530, “IntelliCap® Plus Automatic Capacitor Control: Setup.”

STEP  2.  From the File menu, click on the Load Setpoints option.

STEP  3.  In the dialog box, select the CFG file for the configuration. Then, click on the 
Open button.

STEP  4.  Make any setpoint changes required for this capacitor control. For more 
information, see Instruction Sheet 1023-530, “IntelliCap® Plus Automatic 
Capacitor Control: Setup.”

Note: Be sure to enter the correct values for the “Physical Location” entry (configured 
on Page 2 of the Setup>General screen) and, if necessary, the “Communications RTU 
Address” entry (configured on Page 1 of the Communications>Setup screen). 

When loading a configuration file saved from a previous software revision, it may not con-
figure all the setpoints included with the newer software. The older configuration file will suc-
cessfully load the data it contains, and the new setpoints will remain set at their default values.  
If changes are needed in the default values, they must be manually configured. Refer 
to the “ReadMe.txt” file that is included with the new software for information about 
newly added setpoints.
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Using IntelliLink Software Without a Control

Using a Screenset Follow these steps to view the IntelliLink screens and Help file without connecting to 
a capacitor control or a snapshot:

STEP  1.  Start the IntelliLink software on a computer.

STEP  2.  During startup, click on the Cancel button to close the Connect dialog box.

If the IntelliLink software is already running, choose the Disconnect 
option on the Connection menu. Then, click on the Close Screenset option 
on the File menu to clear the present screenset from memory.

STEP  3.  From the File menu, click on the Open Screenset option.

STEP  4.  In the Open Screenset dialog box, find and select the WMN file whose name 
matches the version name on the setup software for this control.

Using a Snapshot Operational and data-logging information can be saved in snapshots, which are “.vm” 
virtual memory files. The snapshots enable users to view data, generate a report, and 
save or change setpoint configuration files, even when not connected to a capacitor 
control. To access the stored information, connect to the snapshot instead of a physical 
capacitor control. Each capacitor control software installer includes sample snapshots.

Saving Control Settings and Data to a Snapshot
Follow these steps to save control settings and data to a snapshot:

STEP  1.  Connect a computer to the control from which the information will be saved. 
Then, start the IntelliLink software.

For details, see the “Starting IntelliLink Software” section in Instruction 
Sheet 1023-530, “IntelliCap® Plus Automatic Capacitor Control: Setup.”

STEP  2.  From the File menu, click on the Save Snapshot option.

STEP  3.  In the dialog box, specify a file name and location for this snapshot. Then, 
click on the Save button.

If the location to save the file is not specified, the file is saved to the same 
directory as the program files for this for this type of control (for example, 
the default location for PCSD---S report files is C:\ELINE\PCSD---S\). The 
extension “.vm” is added automatically.

Viewing (connecting to) a Snapshot
Follow these steps to view a snapshot file:

STEP  1.  Start the IntelliLink software on a computer. During startup, click on the 
Cancel button to close the Connect dialog box.

If the IntelliLink software is already running, click on the “Disconnect” 
entry on the Connection menu. Then, click on the Close Screenset option 
on the File menu to clear the present screenset from memory.

STEP  2.  From the File menu, click on the Open Snapshot option.

The Open Controller Data File dialog box opens.

STEP  3.  Select the snapshot to use. Then click on the Open button.

STEP  4.  To change the configuration settings in the snapshot, click on the Yes button 
on the Connect to File dialog box. To avoid accidentally changing a setting, 
click on the No button.

The IntelliLink software opens and displays the contents of the selected  
snapshot.
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Using IntelliLink Software Without a Control

Snapshot Changes are Saved Immediately
All changes made to configuration settings in the snapshot are automatically saved to 
disk immediately. There is no need to save the changes in a separate operation.

Generating a Report From a Snapshot
Follow the same procedure used when connected to a capacitor control. For details, 
see  the “Generating Reports” section on page 41.

Creating a CFG File From a Snapshot
This procedure prepares a setpoint configuration for a capacitor control in the field 
without the need to have access to a comparable device.

STEP  1.  Connect to the snapshot.

For details, see the “Viewing (connecting to) a Snapshot” section on page 44.

STEP  2.  Change the configuration settings in the snapshot as needed.

For details, see Instruction Sheet 1023-530, “S&C IntelliCap® Plus Auto-
matic Capacitor Control: Setup.”

STEP  3.  From the File menu, click on the Save Setpoints option.

STEP  4.  In the Save Setpoints dialog box, specify a name and location for this 
configuration file. Then click on the Save button.

If a file location is not specified, the file is saved to the same direc-
tory as the program files for this type of control (for example, the default  
location for PCSD---S report files is C:\ELINE\PCSD---S\). The extension “.cfg” 
is added automatically.

Note: This process does not save the “Physical Location” entry (configured on 
Page 2 of the Setup>General screen) or the “Communications RTU Address” entry 
(configured on Page 1 of the Communications>Setup screen).
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Updating Capacitor Control Software

Follow these steps to update the capacitor control’s software. The Update program, 
installed with the IntelliLink software, easily replaces the existing software with a newer 
revision.

NOTICE
The setpoint values and historical data stored in the capacitor control may be lost  
during the update process .

To capture the data, always generate all needed reports using the IntelliLink 
software and the existing control software before updating the control software .

STEP  1.  Download the new installer from the S&C Automation Customer Support 
Portal and run the installer on a computer.

For details, see the “Start IntelliLink Software” section in Instruction 
Sheet 1023-530, “S&C IntelliCap® Plus Automatic Capacitor Control: Setup.”

STEP  2.  Connect the computer to the LOCAL COMM port on the capacitor control.

STEP  3.  Start the Update program.

(a) In Windows, select Start menu>Programs>EnergyLine.Update. The 
Update window will open. See Figure 19.

(b) Select the desired options. Then, click on the Start Update button.

Note: If the software is being downloaded as part of a troubleshooting  
procedure, selecting the Don’t Preserve Data option is recommended.

Note: If the capacitor control is not connected to COM1 on the computer, click on the 
Communication Setup tab, select the correct comm port, and click on the Connect 
button. Then return to the Update Control Software tab and click on the Start 
Update button.

Figure 19. The Control Software Update dialog box.
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Updating Control Software

The update process takes 5 to 10 minutes. Follow the progress in the lower right 
corner of the window. When the update is complete, the window closes automatically.

NOTICE
If the update process is cancelled after it starts, the software will be deactivated 
in the capacitor control . If cancelling the process, start the update process again .

Note: When the software in the capacitor control is not installed on the computer, an 
error message similar to Figure 20 will open. Obtain the correct software and restart 
this procedure at Step 2.

STEP  4.  Check the Close/Open relays by operating the capacitor bank.

(a) Make sure the LOCAL and MANUAL LEDs are lit.

(b) Follow your company procedures. Press the CLOSE or OPEN button on 
the faceplate to operate the capacitor bank. Verify visually that the 
faceplate LEDs correctly indicate each capacitor bank switch position.

(c) Visually check that the switch-position indicators on the capacitor bank 
switches for all three phases match the Close or Open indication of the 
faceplate LEDs.

The CLOSE and OPEN LEDs indicate the last requested operation. 
Neither LED will be on until the bank is switched for the first time.

Note: The capacitor bank Close command is blocked for a period of 5 minutes after 
an Open command is issued. This delay provides time for the capacitor charge to 
bleed off. For more information, see the “Switching the Capacitor Bank” section on 
page 30.

STEP  5.  Check the Neutral Current/Voltage indication on the faceplate LCD screen.

(a) Check to see that the LCD screen shows: **UNIT OK**. If the LCD screen 
shows **ACTIVE ALARMS**, check the capacitor bank for a problem. The 
alarm condition must be corrected before the control will operate 
correctly.

(b) Press the ENTER button on the faceplate twice. The LCD screen will 
show: **DATA**.

STEP  6.  Press the NEXT button on the faceplate to scroll the data to: **NCAlrmLvl=**,  
and note the value displayed.

Figure 20. Software not installed message.


